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 SOFTWARE UPDATE CHAPTER 1 
 

1 Intruduction 
This manual describes the operating software of the GFS-3000 with 

Control Unit Model 3000-C. For information on the hardware, safety in-
structions and complete operation follow the latest manual for the GFS-
3000 (edition 6 or higher). It can be downloaded from the Walz homepage 
(www.walz.com). This manual here only documents the software installed 
on the instruments with Control Unit Model 3000-C sold until end of 2011. 
The GFS-Win software will operate on the Panel-PC of the Control Unit 
Model 3100-C. The latest GFS-Win software can also be used to operate 
the GFS-3000 with Control Unit Model 3000-C from an external PC. The 
latest GFS-Win version, which can only operate Control Unit Model 3000-
C, but not Model 3100-C is GFS-Win 3.24. The first version capable of 
operating both models in external mode is GFS-Win 3.30. 
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2 Software Update 

2.1 Software Update 
2.1.1 Using the GFS-3000 Panel PC Update Software 

The latest available Panel PC software version can be found and 
downloaded from the Walz homepage (www.walz.com). The software co-
mes with an update-program, which serves to load the software to the 
panel-PC of the Control Unit Model 3000-C. The update-program works 
with the following windows systems: Windows 95, 98, 2000, Me, NT, XP, 
7. Please note that also the GFS-Win software should be updated. 

IMPORTANT NOTE: 

Do not disconnect or switch off the GFS-3000 during the update process (if 
the status window is colored red, Panel PC shows messages of Zmodem). If 
an error occurred during the process, repeat update. 

Three exe-files are necessary to run a 
correct update. The program transferring 
the software (GFS-3000upd.exe) and two 
exe-files (gfsu.exe and gfsu2.exe), which 
will be transferred. Start the program 
GFS-3000upd.exe and follow the instructions, shown in the first message 
window. 

After pressing OK the applica-
tion window will appear and show 
the status of its automated search 
for Com-Ports in its lower screen. 
Having checked the Ports, the pro-
gram asks for switching on the 
GFS-3000. Before further proceed-
ing make sure that the Panel PC is 
completely started and approve by 
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pressing OK. Afterwards press Search GFS-3000 to find the currently in-
stalled software version. 

When the GFS software ver-
sion is found, an OK will appear in 
the status window. Press UPDATE 
to start the process. The window 
will appear red to show you that 
the update is running. 

This may take a few minutes. 

After the File transfer the GFS-
3000 will reset and start again (a 
message box appears). 

When the GFS-3000 is completely started, the update is complete and 
the instrument can be switched off and disconnected or used. 

 

2.1.2 Updating the GFS-Win Software 
The latest available GFS-Win software version can be found and 

downloaded from the Walz homepage (www.walz.com). GFS-Win has 
been extensively tested with Windows XP. It also runs with Windows98, 
2000, ME and Windows 7. The GFS-Win Software is required for  
downloading data files or uploading program files. It can also be used to 
run the instrument with an external PC. For installation of GFS-Win and 
file transfer see chapter 4. 



CHAPTER 3 SOFTWARE DESCRIPTION 

3 Software Description, Panel PC Software 

3.1 Introduction 
The Panel PC software is software assigned to the GFS-3000 Portable 
Photosynthesis System. It runs on the Panel PC of the GFS-3000 with 
Control Unit Model 3000-C. It is specialized to assess the photosynthetic 
performance of plant samples by gas exchange measurement. 
 

3.2 Start 
After the GFS-3000 power has been switched on and the software has been 
loaded, the display shows the Settings window (see Fig. 1). 
  

Fig. 1: Panel PC surface after the power has been switched on, but also 
showing the bottom-bar, which only appears after the Measure Mode 
has been switched on. 
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3.3 General Information on the User Interface 
The GFS-3000 can be operated via touching certain areas on the touch-
panel either with the provided plastic pen or simply with fingers. Areas 
with a black back-ground are active, which means they can be selected. 
The graphical user interface is divided into six zones: 

• The upper bar displays the main menu and the information about 
the remaining battery capacity. It also contains a button ESC. If this 
button is active, it can be used to escape from the chosen function. 

• The central window displays chosen windows or chosen sub-menus 
and dialogs. In Fig. 1 the Window Settings is displayed. 

• A Quick-View Column on the right displays six user-selectable val-
ues.  

• After the Measure Mode has been switched on, a bar appears at the 
bottom of the screen containing six buttons with frequently used 
commands.  

• Above the frequently used commands is an empty area, where in-
formation may be shown. 

• In the lower right corner the system time is displayed.  

• Since version 1.31 there is a button above the time for changing the 
contrast  of the display. 

7 
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3.4 Main-Menu 
The Main-Menu contains four topics: System, Window, Option and Op-

tion2. Fig. 2 gives an overview of the sub-menus, which will appear under 
these four topics. 

 

 

 

  
Fig. 2: Overview of the four Sub-Menus under the different topics of the 

Main Menu 

The System submenu serves to switch the system on or off or to enable 
connected hardware. The Window submenu gives access to different win-
dows for managing the measurement. Option gives access to less frequently 
used functions and settings, like calibration or file-management. Option2 
contains mainly information about the system, but also hosts the function 
for the adjustment of the touch panel. 
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3.5 Quick-View Column 
The Quick-View Column on the right side of the main 

window shows six values, which are user-selectable. To allo-
cate a new value to a certain field of the Quick View Column 
select this field. A table with all available values will appear. 
Select your value of choice. It will now be shown in the Quick-
View Column.  

 

3.6 Frequently Used Commands Buttons 

A bar with frequently used commands is located at the bottom of the 
main window. The Mode-Button on the left shows the state of the solenoid 
valves controlling the gas flow. The Mode can be MP or ZP. Depending on 
the Mode the next three buttons change their appearance and function.  

If Mode MP (Measuring Point) is chosen, the reference gas is flowing 
through the reference cell and the measuring gas is flowing through the 
sample cell of the analyzer. If a leaf is enclosed, a Measuring Point (MP) 
can be stored, using the button Store MP. If the cuvette is empty, a Zero 
Point which includes the cuvette, can be stored using the button Store 
ZPcuv.. This button is disabled if Measure Mode is off, Start Storing is 
activated or if a program is running. 

Once an hour or after changing CO2- or H2O absolute concentration a 
Zero Point must be measured to compensate differences between the two 
gas analyzers. If samples are enclosed for a short time, ZPcuv should be 
preferred. For long term measurements it is not possible to measure ZPcuv, 
but only Zero Points of the infrared gas analyzer alone (ZPirga). 

9 
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If Mode ZP is chosen (by pressing the field Mode MP) the measuring 
gas is vented after passing the Measuring Head. The reference gas is split 
and flows through the reference and sample cell of the analyzer. 

A zero point of the differential signal of the infrared gas analyzer can be 
stored using the button Store ZPi (short for Store ZPirga). It will be marked 
as ZPi in the record file. A leaf can be enclosed in the cuvette during this 
procedure. For more detailed information on ZP and MP see GFS-3000 
manual. 

 

Av
Purge TimePurge Time

Av
Purge TimePurge Time

Store ZPirga

ZP-Mode MP-Mode

Fig. 3: Time course of an Auto ZPirga measurement 

Auto ZP does the following procedure, which is illustrated in Fig. 3, to 
measure a ZPirga: The solenoids of the gas ways are switched into ZP-
Mode, the gas analyzers are purged for a defined period of time, a ZPirga is 
stored, After storing ZPirga the solenoids will be switched back to MP 
mode and again the gas analyzers are purged. 

The Purge time can be set with Purge time in the submenu Option. The 
averaging time for Zero Points is the same as the averaging time chosen for 
Measuring Points. It can be set in the Settings Window with the button In-
terval.  

The additional two buttons on the right Store MP+Fm and Store MP+Y 
are only active, if a fluorescence module is connected and enabled. 

10 
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 In the lower right-hand corner, above the time there is a field 
serving to adjust the contrast of the display. Touching it continuously, will 
change the contrast into one direction. Touching it again, will change the 
contrast into the other direction. 

3.7 Submenu System 

Measure
mode ON

 Opens up the dialog for system configuration 
(see Fig. 4). First select the Standard Head. Only then 

a Fluorescence module may be selected. After OK has been pressed, the 
infrared gas analyzer is switched on, and all modules of the system are ini-
tialized. 

 Fig. 4: Dialog for system configuration 

 

Measure
mode OFF

 After the Measure Mode has been switched on, 
the button changes and can now be used to switch the 

system off. Most important the gas analyzers are switched off with this 
button. During the switch-off procedure, the system is flushed with dry air 
to avoid condensation in the stored system or during cold transport. For this 

11 
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En/disable 
components 

Standby 
Mode 

to be effective, the Measuring Head needs to be closed and the drier needs 
to be functional. With Esc the flushing can be stopped. After flushing, the 
H2O control is turned off. Now, the power of the system may be switched 
off. Also the actual configuration is stored when the Measure Mode is 
switched off. 

The button for standby mode switches all 
controls off. The gas analyzer remains switched 

on and warmed up. 

Allows to change the system configuration (Fig. 
2), when the Measure Mode is on. 

 

3.8 Submenu Window 
The available windows are:  

• Settings; to change measuring parameters.  

• 1Chart; to display one full-size chart of any measured magnitude. 

• 2Char; to display two half-size charts of any measured magnitude. 

• Value; to obtain an overview over all current values. 

• Report; to see stored values. 

• Program; to write, read or change user-programs. 

• Graph; to plot two magnitudes versus each other (the data points 
from the report file are used). 

 

3.8.1 Window: Settings 
The Settings window opens automatically after the start of the system 

(see Fig. 1). In general clicking on the parameter whose value has to be 
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changed starts an input-dialog. The control elements in the Settings-
Window are arranged in four different groups: General, Control Unit, 
Measuring Head, Fluorescence Module. The Fluorescence group is on the 
second page of the Settings window. Only the General group is active when 
the Measure mode is off. After pressing Measure Mode ON all buttons in 
the Settings window can be accessed. 

13 
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Filename 

3.8.1.1 General 
The Filename button allows to entitle an 

upcoming measurement or to open an existing file. 
Newly collected data will be appended to the chosen record file. If a new 
file is created, the reference for the calculation (Area or Weight) must be 
entered. Area is suitable for flat leaves; Weight should be used for Conifers, 
Lichens or Mosses. The lower part of the button counts the lines stored in 
the record file. The reference (Area or Weight) cannot be changed within a 
file. To delete files use Data Management in the submenu Option. 

Start 
Storing 

Interval 
03/60 
NO 

Auto ZP 

The three buttons Start Storing, Interval and 
NoAutoZP serve to control the automatic storage of 
record sets. (Automatic storage should not be mixed 
up with running a user-program). The Start Storing 
button starts the recording. First System/Measure 
mode ON must be enabled and a filename selected. 

The other two buttons control the measuring sequence. Three different se-
quences are available.  

1. n*MP: records a series of n Measuring Points using a defined inter-
val (see Fig. 5a). Mode MP and NoAutoZP must be selected.  

2. n*ZP: : records a series of n Zero Points using a defined interval. 
Mode ZP and NoAutoZP  must be selected. The difference between se-
quence 1 and 2 is just the Mode of the gas ways, MP or ZP (see manual for 
GFS-3000).  

3. n/x*(AutoZP + x*MP repeats the sequence AutoZP + x*MP (see Fig. 
5b) using a defined interval between MPs. The sequence starts with a Zero 
Point. The sequence is repeated until the requested amount of Measuring 
Points (n) are stored. 

14 
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a

b

Fig. 5: Illustration of measuring sequences, a: sequence 1, b: sequence 3. 

The Interval button defines the averaging time (s) and the measuring in-
terval (s) for the storage of record sets (see Fig. 5). First, the measuring 
interval is requested. It can range from 1 to 600s. Afterwards an averaging 
time has to be entered. It can range from 1s to the time that was assigned to 
the measuring interval. The averaging time entered here, is not only used 
during automatic storage, but always when record sets are stored. 

The NoAutoZP-button defines how often the system shall switch into 
the ZP mode and measure a zero point of the gas analyzer. If NoAuto ZP is 
chosen, a cycle of n Measuring Points (n*MP) or n Zero Points (n*ZP) will 
be stored depending on the selected mode (MP or ZP). This sequence is 
recommended for short-term experiments, a ZP must be measured directly 
before. If AutoZP + x*MP is selected and start storing is clicked, the cycle 
(AutoZP + x*MP) will be repeated. The sequence n/x *(AutoZP + x*MP) is 
recommended for long-term experiments. Zero Points will automatically be 
measured between series of Measuring points, giving a higher accuracy.  

When a fluorescence module is used, additional choices for the measur-
ing sequence can be made (see chapter 3.8.1.4 and manual for GFS-3000).  

15 
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Object 

Area 
8.00 

Prg.name 

Start 
program 

Last prg 
command 

 

The Object number will be stored with the meas-
ured data in the record file.  

Input of the value for the reference Area or 
Weight, which is used for calibration and stored with 

each following data record. The value, unlike the reference type, can be 
changed within a file. The reference type is fixed, when a new file is cre-
ated.  

The three buttons, Prg.name, Sart program, and 
Last prg command control the execution of user-
programs. A user-program is a user programmable 
experiment like e.g. a Light Curve, which can be 
edited in the Program-Window (for further informa-
tion proceed to chapter 3.8.6 and see GFS-3000 

manual). With Prg.name, a user-program can be selected and with Start 
program it is started or stopped. Before a program can be started "Sys-
tem→Measure mode ON" must be enabled and a Filename and program 
name has to be entered.  

3.8.1.2 Control Unit 

CO2 
OFF 

Flow 
00 

Input of the Flow rate between 600 and 900 
µmol/s (equivalent to 800 to 1200 ml/min). The Flow 

can only be switched off, when neither H2O nor CO2 are controlled by the 
instrument (H2O mode and CO2 mode are off). Vice versa the H2OMode and 
CO2Mode can only be switched on, when Flow is on. 

The user can choose between two different op-
tions:  

1. CO2 control off; to use ambient air. In this case the CO2 absorber 
tube has to be exchanged against the provided mixing volume (3000-
C/MV). A solenoid valve closes, so that no CO2 can diffuse to the system. 

16 



 SOFTWARE DESCRIPTION CHAPTER 3 

2. Set an absolute CO2 concentration in ppm: the set-value can be cho-
sen between 0 and 2000 ppm. The CO2 can only be changed, when the flow 
is switched on and also requires the connection of the CO2 absorber tube. 
(The CO2 absorber needs to be functional. It has to be exchanged, when 
turned violet even if the color has turned back to pale. In dry climate the 
indicator may not work well)  
A small cartridge supplies the CO2, into a storing vessel. If the CO2 mode is 
on and the pressure in the vessel drops below 2.5 bar, a warning appears, 
that the CO2 cartridge has to be exchanged. After the first warning the CO2 
control can still run for a few hours. Do not exchange the CO2 cartridge 
before the warning appeared. If you want to force the warning to appear, 
release the pressure with the screw at the front of the CO2-control unit. 
Before closing the screw, open it so far that the seal-ring can pull back into 
the groove of the screw. 
 
H2O Mode

OFF 
The user can choose between off and two further 

modes:  
SetVal 
xxx 1. H2O Mode off; The air is directed straight through 

the H2O valve, without passing the Drier or 
Humidifier.  

2. H2O Mode absolute concentration in ppm; the resulting relative hu-
midity inside the cuvette depends on the cuvette temperature. 

3. H2O Mode relative humidity in %; the Measuring Head has to be 
connected and the TempMode must be set to Tcuv. Note that not the relative 
humidity of the cuvette is controlled, but the relative humidity entering the 
cuvette. The humidity required is calculated from the set value for Tcuv, it 
is adapted when Tcuv is changed. 

 
For option 1 or 2 a set value must be entered. After the control mode 

has been defined the button underneath for the set value is active, and 
serves to change the value. The unit of the set-value is ppm or relative hu-
midity (rH), depending on the H2O control mode. 

17 
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Imp. 
00 

Light 
PARtop 
00 

T. Mode 
OFF 

SetVal 
xxx 

3.8.1.3 Measuring Head 
Impeller speed to ventilate the cuvette volume 

effectively. The values can be set between 0 and 9, 
setting 7 is recommended. At lower speed the response time is slower, the 
temperature control gets less effective and the boundary layer is thicker. 

The Light Mode determines which light sensor is 
used to control the light intensity, PARtop (sensor in 
the upper chamber side), PARbot (sensor in the lower 

chamber side), or PARamb (MQS-B/GFS sensor for ambient light). The 
Light-Source Factor (see chapter 5.1.2) is effective for the indicated light 
value of the chosen sensor, if PARtop or PARbot are chosen and the light is 
switched on, but remains ineffective, if PARamb is chosen or the light is 
switched off. To set a light value a light source must be connected and 
mounted onto the cuvette. A set value between 0 and 2000 µmol m-2 s-1 can 
be chosen.  

For the temperature control, the user may choose 
between off and three further modes: 

1. off: No temperature control. 

2. Follow ambient temperature: The ambient temperature is measured 
at the external heat exchanger fan of the lower cuvette half and for the con-
trol of the cuvette temperature. An offset can be entered, which is the set 
difference between Tcuv and Tamb.  

 3. Set cuvette temperature: the cuvette temperature is kept constant at 
the set value. 

4. Set leaf temperature: Leaf temperature is kept constant. 
When options 3 or 4 are chosen, a set value must be entered which can 

be changed, using the SetVal button below. The temperature control is slow 
to avoid a large temperature overshoot, which could cause water condensa-

18 
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tion. The minimal temperature, the standard measuring head can reach, is 
about 10 °C below ambient temperature and can be increased up to 50 °C.  

3.8.1.4 LED-Array/PAM-Fluorometer 3055-FL - Optional  
The control elements for the fluorescence module are located on the 

second page of the Settings Window and become active, when the LED-
Array/PAM-Fluorometer 3055-FL is connected.  

Fig. 6: Second page of the Settings-Window hosting the Fluorescence Module 
3055-FL 

It is enabled in System → En/disable components. Create a file for data 
storage (with Filename in Window Settings), before performing any fluo-
rescence measurements. The fluorescence will be measured in mV. It can be 
continuously observed (as Ft) in the Chart Window.  

Z-Offset
 

08 
Determination of fluorescence Z-Offset. This 

offset is caused by background fluorescence and some 
small preset offset. Its value will be subtracted from every fluorescence 
measurement. For its determination, the fluorescence module needs to be 
placed in its proper measuring position, the sample in the cuvette needs to 
be replaced with black non-fluorescing foam, and the measuring light needs 

19 
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to be on for at least 5 s. The Z-Offset needs to be determined again after 
any change in the Gain or ML-Ampl (see below), or any change in the opti-
cal setup (e.g. new cuvette). It is good practice to determine it after the 
system has been started. 

 
Gain 
Low 

Pressing the Gain-button changes the sensitivity 
of the sensor between low and high by a factor of 3.7. 

A high gain is only recommended for small samples. It improves the resolu-
tion, but not the signal to noise ratio. It can be set to high, if the signal re-
mains below 200 mV, even after adjusting the measuring light. After the 
adjustment of Gain or ML-Ampl the Z-Offset needs to be determined. 

ML-Ampl 
10 

ML 
ON 

 
Switches the measuring light (ML) on or off. The 

button indicates the actual state of the light 
. 

ML-Ampl changes the intensity of the measuring 
light. The higher the intensity, the better is the signal 

to noise ratio. Nevertheless, it should not be chosen to high to avoid an 
actinic effect or overloading of the fluorescence signal during Fm determi-
nation. To test, whether the measuring light causes an actinic effect, ob-
serve the fluorescence in a dark-adapted sample after switching the measur-
ing light on, or after inserting the sample. If the measuring light causes a 
slow fluorescence increase by itself, it is to high. To avoid overloading, the 
fluorescence value for the dark adapted sample should range between 100 
and 600 mV. The recommended value for ML-Ampl is 10. After the adjust-
ment of Gain or ML-Ampl the Z-Offset needs to be determined. 

Sat-Int 
12 

Sat-Int 
12 

 
Sat-Int changes the intensity of the saturating 

light pulse in steps from 1 to 12 

SatWidth 
0.6 

. 
SatWidth changes the duration of the saturation 

pulse in steps of 0.2s within the range from 0.2 to 

20 
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1.2s.  

The saturating light pulse serves to fully reduce 
photosystem II. It is activated with the button Store 
MP+Fm or the button Store MP+Yield at the bottom of 
the screen. After every saturating light pulse, the kinetic 
of the fluorescence signal is displayed in a small graph. 

The Fm or Fm’ fluorescence values are determined between the point, 
where the plateau is reached and the point, where the light pulse is switched 
off. The level of the stored Fo and Fm or F and Fm’ values are indicated by 
broken lines. The intensity and duration of the saturating light pulse should 
be adjusted so that the plateau lasts for 200 to 300 ms. If no proper plateau 
is reached, the intensity of the saturation pulse is to low. If the fluorescence 
is quenched during the pulse, it is to high or long. For most applications 
maximal pulse intensity can be recommended. 

FarRed 
OFF 

FR-Int
10 

 Changes the intensity of the far red light (FR-Int) 
in steps from 1 to 12.  

Switches the far red light on or off.  

Fo’-Mode 
OFF 

Enables or disables the Fo'-Mode in conjunction 
with Yield measurements. Usually Fv/Fm of a dark 

adapted sample is measured before a series of Yield measurements. The Fo 
of the Fv/Fm measurement is used for the calculation of qP and qN. At 
higher light intensities, Fo quenching can occur, leading to an overestima-
tion of qP and qN. If the Fo'-Mode is enabled, the actinic light is automati-
cally switched off after every saturating light pulse, then far-red light is 
applied for 2 s before the actinic light is switched back on. During the far-
red illumination the Fo' is measured and used instead of Fo for the calcula-
tion of qP an qN. 

ETR-Fact
0.84 

Definition of the ETR-Factor, which relates to the 
fraction of the incident light, which is absorbed by the 
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1Yield 
/05MP 

Store MP

Av
Purge TimePurge Time Meas. Int.

Av
Meas. Int.

Av
Meas. Int.

Av
...

Store ZPirga Store MP Store MP

MP: x times per ZP, n MPs total

Store Yield: once per y MP

Store MP

Av
Purge TimePurge Time

Av
Purge TimePurge Time Meas. Int.

Av
Meas. Int.

Av
Meas. Int.

Av
Meas. Int.

Av
Meas. Int.

Av
Meas. Int.

Av
...

Store ZPirga Store MP Store MP

MP: x times per ZP, n MPs total

Store Yield: once per y MP

Store MP

Meas. Int.
Av

...Meas. Int.
Av

Store MP

n MPs total

Meas. Int.
Av

Store Yield: once per y MP

Store MP Store MP

Meas. Int.
Av

Meas. Int.
Av

...Meas. Int.
Av

Meas. Int.
Av

Store MP

n MPs total

Meas. Int.
Av

Meas. Int.
Av

Store Yield: once per y MP

Store MP

leaf. It is used for the calculation of ETR. A mean value for green leaves in 
moderate climate is 0.84, which should be used, if the ETR-Factor can not 
be determined. When using the Imaging-PAM, the ETR-Factor is automati-
cally determined during the absorption measurement. 

Fig. 7: Illustration of Measuring Sequence, with automatic yield measure-
ments 

 
This button works in cooperation with the buttons 

Start Storing and Interval from the first page of the 
settings window. In addition to the available measuring sequence shown in 
Fig. 4 also a yield-measurement can be automatically triggered after a cer-
tain amount of Measuring Points. The sequences in Fig. 5 then change to 
the sequences in Fig. 7. 
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When the fluorescence module is enabled, the two buttons of the bot-
tom bar on the right, which serve to trigger saturating light pulses, become 
active. They are inactive for 10 s after each saturating light pulse to allow 
cooling time for the LEDs. 

Store  
MP+Fm 

Store 
MP+Y 

Serves to store a Measuring Point including gas 
exchange data, automatically triggers a saturating light 

pulse and stores the fluorescence data, Fo, Fm and Fv/Fm. The leaf should 
be dark adapted before an Fv/Fm measurement. A healthy dark adapted leaf 
reaches values around 0.8 for Fv/Fm. If the user is interested in qP, qN and 
NPQ, an Fv/Fm measurement must be recorded prior to a sequence of Yield 
measurements, since the calculation of qP, qN and NPQ require Fo and Fm. 
With every new sample a new Fv/Fm measurement is required 

 
 Serves to store a Measuring Point including gas-

exchange data, automatically triggers a saturating light-pulse 
and stores F, Fm’, Yield and ETR. If the user is also interested in qP, qN and 
NPQ, a Fv/Fm measurement must be made before a sequence of Yield 
measurements, since the calculation of qP, qN and NPQ depends on Fo and 
Fm. The calculation of Yield and ETR is independent of Fv/Fm. 

 

3.8.1.5 Fiberoptics/PAM-Fluorometer 3050-F - Optional  

ML-Frq 
Low 

The Fiberoptics/PAM-Fluorometer 3050-F works very similar to the 
Fluorescence module 3055-FL. In the GFS-Win software or at the Panel PC 
enable the Fiberoptics-version. 

In difference to the Fluorescence module 3055-
FL, the frequency of the measuring light can be set 

manually. It is recommended to use the low frequency in low light and in 
the dark, where the measuring light would otherwise have an actinic effect 
on the sample. The high frequency results in a smoother signal. It can be 
used, when the environmental light intensity is so high that the measuring 
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Gain 
High 

ML-Ampl 
10 

light is weak in comparison. During a saturating light flash, the frequency 
is changed automatically.  

The intensity of the Measuring light  should be 
set to 10 unless, it needs to be decreased, when the 
distance to the sample is very low.  

The Gain should be set to high, when the 
Fluorescence signal of a dark adapted sample is lower 

than 200 mV. 
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3.8.2 Window: “1 Chart” and “2 Charts” 
The Chart windows simulate the function of a chart recorder Fig. 7 

shows the window "2 Charts" (Fig. 8). The record starts instantly when the 
measure mode is switched on. The chart holds the data of all values from 
the last hour. Two magnitudes can freely be chosen for display. 

Fig. 8: Chart window, A (CO2-Assimilation)  and E (H2O-Evaporation) 
being displayed. 

To change the y-axis select the y-scale. Now on the right 
hand side a control-column appears. It has the following func-
tions: upper limit Y↑, Y↓, Value, lower limit Y↑, Y↓,  fine/full 
scale, which serve to change the scale and Value, with which a 
new magnitude can be chosen. 

Y↑, Y↓ change the upper or lower limits of the scale in 
steps of 5% of the maximum range. 

The buttons fine/full scale fit the curve automatically. In full 
scale the y-scale becomes the maximum range of the displayed 
magnitude. In fine scale the y-scale becomes 5% of the 
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maximum range. It also shows the curve, if it is outside the full-scale range. 
To leave the y-scale options press ESC. 

To change the x-axis select the x-scale. Now on the right 
hand side a control-column appears. The horizontal arrow keys 
can modify the scaling of the time-axis. The minimum time 
range displayed are the last five minutes, maximum is 60 min-

utes. 

Also stored data can be displayed in the chart. To do this, press Option: 
Report→Chart. The data in the chart memory will be deleted and replaced 
by the data stored in the report. Now the data will not be plotted versus 
time as with life data, but versus measuring point. The system goes back to 
collecting life data after pressing the button again (Option: Life→Chart). 
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3.8.3 Window: Graph 
 

 

Fig. 9: Graph window 

In difference to the Chart window, where magnitudes are plotted versus 
time in the Window Graph the magnitude for the x-axis can be freely cho-
sen. 

Only the data stored in the report and only the data belonging to one 
object are plotted. In Fig. 9 the data of Object No. 2 are shown. This choice 
can be changed by pressing on the field with the wording Object No 02. 
The data points are connected in dependence of the order in which they 
have been measured. 
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3.8.4 Window: Values 
 

Fig. 10: Values window 

The Values window (Fig. 10) shows all the measured and calculated pa-
rameters that also appear in the Report File after saving Measuring Points 
or Zero Points. The second page of the Values window can be reached with 
the double arrow button. For further information about the underlying cal-
culations see manual for the GFS-3000.  
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3.8.5 Window: Report 
 

Fig. 11: Report window 

The Report window shows all parameters that are stored with each 
Measuring Point, ZPcuv or ZPirga. The displayed magnitudes can be cho-
sen by selecting a column. With the arrow keys on the left allow navigation 
within the data record. For more details on the parameters stored, please 
read the GFS-3000 manual. 
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3.8.6 Window: Program 
User-programs can serve two different purposes. They can be used to 

store the actual settings to simplify the start-up of measurements once the 
settings have been established. Or they can be used to run complete meas-
urements. 

The user-programs can be listed with the Program window and started 
with the button Start in the Settings window . A program consists of a list of 
command lines and will be executed line by line. Almost all commands in 
Table 1 (below) are commands for entering a set value (e.g. for flow, light, 
cuvette temperature, storing interval).  

 

Fig. 12: Program window 

Also programs, which have been received from an external PC running 
GFS-Win can be displayed and changed with the Program window. Every 
change is saved directly in the program-file. The upper half of the window 
shows a listing of selectable commands, it serves to enter new program 
code. The lower half serves to display the user-program. Beside the head-
line Program listing the total time is displayed the program-run will take.  
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To change a program, select the line, which shall be changed. If the 
command requires a value, an input box will appear. The user will be very 
familiar with these input dialogs, because they are the same or similar to the 
dialogs, which appear, when settings shall be changed directly. The change 
will be saved immediately. Keep a safety copy of the program file before 
making changes. The process is explained in more detail below: 

 
With Prg. name a new or existing program file can be 

opened. The button underneath, Compon., serves to scroll 
through the subsets of available commands. The subsets 
are General, Control Unit, Measuring Head and 
Fluorescence Module. With the arrow keys a certain 

command can be selected. A small arrow points to the selected command in 
the command listing. After Set has been pressed the selected command will 
be entered into the program listing. The position of insertion is after the line 
selected in the program listing. If a value is required for the command, an 
input-dialog will appear. 

The arrow keys serve to navigate within the 
program listing. The number in the upper line, here 
08/111, indicates which line is selected and the total 
amount of lines in the user-program. Del deletes the 
selected line, Copy copies the selected line. The line 
copied to the memory is shown in the line above the 

bottom bar. With Ins it can be inserted multiple times. With Set the selected 
line of the program listing can be changed.  

It is more convenient to write a program in GFS-Win and upload it to 
the GFS-3000 and only change single commands, if necessary in the field. 
The changed user-program can be downloaded with GFS-Win (see chapter 
4.3) 
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3.8.6.1 Start and Stop user programs 
The user-program can be started and stopped in the Settings window. 

With the button "Start program". 

If a program is started, the manual input of a file name, set-values or 
other parameters is blocked. Only the button "Stop" for stopping the pro-
gram will be enabled. Also comments can be entered. They will be stored 
with the next data-record. 

The program will stop after the last command is carried out. If the stor-
age of data-records is enabled at the end of the program, it will be stopped. 
All other settings made during the program-run, remain active. Of course, 
they can now be changed manually. 

 

3.8.6.2 Command List 
Table 1: Command List, this list only contains the commands implemented 

on the Panel-PC. With GFS-Win there are more commands available. 

 General Commands 
Interval = to define an interval (s), which has to elapse before 

the next command of the program is carried out: 
With "Start storing" before the "Interval"-
command, data points will be stored during the 
interval. 

Storing Interval =  to set the Measuring Interval- and Averaging Time 
for the storage of data points: 

Start storing to initialize the storage of data records: 
This command is only performed, if it is followed 
by the command "Interval =". 

Stop storing to stop the storage of data points. 
Repeat Run to repeat the run from start. 
Comment  = to enter a comment for the report-file:  
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The comment will be stored in the report-file with 
the next storage of gas exchange data, like usual 
comments entered manually. 

Count up Object No Increases the value for Object number by 1. 
Store MP ZP performs the same action as pressing the button 

Store MP or Store ZP depending on the actual 
mode. 

 Central Unit 
Set Flow = to set the gas flow rate (µmol/s) through the meas-

uring cuvette.  
This command needs to be given before switching 
the CO2 control or H2O control on, but after switch-
ing them off. 

Set CO2 = to set the CO2 control to the indicated value (ppm). 
This command needs to be given after switching the 
flow on, otherwise it will not be performed.  

CO2 Control off to switch the CO2 control off. 
Set H2O(ppm) =  to set the H2O control to the indicated value (ppm). 

This command needs to be given after switching the 
flow on, otherwise it will not be performed. 

Set H2O(rh) = to set the H2O control to the indicated value (rela-
tive humidity % entering cuvette). 
Give the commands "Set Tcuv" and "Set Flow" 
before this command. 

H2O Control off to switch the H2O control off. 
Mode =  to chose between MP- and ZP-Mode: 
Auto ZP = to set the purge time and averaging time (temporar-

ily), and perform an automatic ZPirga determina-
tion: 
Firstly, the solenoids switch to ZP-Mode, then the 
system is purged for the indicated time, ZPirga is 
averaged over the indicated time and stored. After-
wards, the solenoids switch back to MP-Mode, and 
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the system is purged for the indicated time before 
the run continues. Auto ZP replaces the following 
series of commands: 
 
Stop Storing 
Mode = ZP 
Interval = Purge Time 
Storing Interval = Av Time/ Interval Time equal 
Store_MP_ZP 
Storing Interval = Back to what it was 
Mode = MP 
Interval = Purge Time 
Start Storing, if it was active before 

 Measuring Head 
Impeller = to set the impeller speed. 

If the impeller speed is set to 0, the light and the 
Temperature Control needs to be switched off first. 

Follow Tamb + = to set the temperature control for Tcuv to follow the 
ambient temperature Tamb. A positive or negative 
offset value can be entered, if Measuring Head Ver-
sion is higher than 1.20. 

Set Tcuv =  to enter a set value for cuvette temperature; the 
TempMode will be set to Tcuv. 
Set impeller speed beforehand ("Impeller ="). 

Set Tleaf = to enter a set value for leaf temperature; the Temp-
Mode will be set to Tleaf. 
Set impeller speed beforehand ("Impeller ="). 

TempControl off to switch the temperature control off.  
Don't use this command, if the H2O mode is set to 
relative humidity. 

 The commands for setting the light have changed 
with Panel-PC Software Ver.1.35 

PARtop = 
PARbot = 

to control the light. The command determines, 
which sensor is used to control the light source. 
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PARamb = 
 

PARtop/PARbot: The light source will be regulated 
with the sensor in the upper/lower cuvette half. 
With PARtop and PARbot, the Light-Source Factor 
will be taken into account. PARamb: The ambient 
sensor needs to be placed under the light source. 
The value determines the light value in µmol m-2 
s-1. 

PARtop follows 
PARamb 

only for Measuring Head Version 1.20 and higher. 
These commands can be used to imitate the light 
measured with the external sensor PARamb with 
the Fluorescence Module 3055-FL. The light is 
controlled with PARtop or PARbot according to the 
value measured by PARamb. The Light-Source 
Factor is taken into account. 

PARbot follows 
PARamb 
 

Light Control off to switch the light off 
 Fluorescence Module 3055 or 3050-F 
1Yield/y*MP  to set the clock for giving saturating pulses during 

fluorescence measurements. A yield will be meas-
ured every yth MP.  

Fv/Fm to trigger a single Fv/Fm measurement: 
An Fv/Fm measurement includes a saturating light 
pulse with Fo and Fm determination. Gas exchange 
data will be determined and stored beforehand. 
They will be averaged according to the actual Av-
eraging Time, which can be set with the command 
"Storing Interval". 

Yield to trigger a single Yield measurement:  
A yield measurement includes a saturating light 
pulse with F and Fm' determination. In dependence 
on the Fo-Mode an Fo' determination will be per-
formed after the light pulse. Gas exchange data are 
averaged and stored before the yield measurement. 
They will be averaged according to the actual Av-
eraging Time, which can be set with the command 
"Storing Interval".  
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Fo'-Mode FL = to set the Fo-Mode: 
On/Off: Fo' is determined/not determined with 
every Yield determination.  

Gain FL = to set the gain (high/low). 
After changing the gain, the Zero-Offset of the 
Fluorescence Module needs to be set again. 

FarRed FL = to switch the far red light on or off. 
M-Light FL = to switch the Measuring Light on or off. 
SatWidth FL = to set the duration (s) of the saturating light pulse. 
Sat-Int FL = to set the light intensity (steps) of the saturating 

light pulse. 
ML-Amp FL = to set the amplitude (intensity) of the modulated 

measuring light.  
Note, after changing this setting, the Zero-Offset of 
the Fluorescence Module needs to be set again. 

FR-Int FL = to set the intensity of the far red light without 
switching it on (use command "FarRed FL"). 

Set Z-Offset FL to set the zero-offset for the fluorescence module: 
This command will interrupt the user-program and 
ask the user to insert a black non-fluorescent foam 
into the cuvette. The user can circumvent this 
measurement by choosing "Cancel". The user-
program will proceed after ok or cancel have been 
chosen. 

ETR-Fact FL = to set the ETR-Factor, which is the factor used to 
calculate the electron transport rate (ETR) from 
yield measurements and PAR.  

ML Frequency F = The frequency of the measuring light can be set to 
high or low with the Fiberoptics PAM-Fluorometer 
3050-F. 
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3.8.6.3 Programming Rules 
When the GFS-3000 is controlled manually via the Settings window, 

some settings are blocked if another setting is not made before. For exam-
ple: the CO2 control cannot be switched on, if the flow was not set before. 
The same is true for most settings during the program-run. When program-
ming, please pay attention to the rules and recommendations for the se-
quential order of commands: 

Switching the system or controls on: First Measuring Head:  Impeller 
followed by Temperature and Light (chose Light Control before value). 
Then Control Unit: Flow followed by gas concentrations. 

Switching the system or controls off: Use reverse order: First Control 
Unit: gas concentrations, followed by Flow. Then Measuring Head:  Tem-
perature and Light followed by Impeller. 

The "Storing Interval" shall be set before any measurements, also before 
fluorescence measurements. 

It is recommended to define all parameters in the program instead of setting 
the parameters manually via the Settings window before starting a pro-
gram-run. 

 

3.8.6.4 Timing during Programming 
The Panel PC conducts one command per second, in contrary the GFS-

Win software executes several of those commands within a second. Some 
commands require some time to elapse. The most prevalent is "Interval". It 
is used to define a time that has to elapse before the next command is car-
ried out. If it is preceded by "Start storing", values are recorded during this 
Interval. Another command requiring time is "Auto ZP". It is equivalent to 
the button "Auto ZPirga" in the Settings Window. Also the fluorescence 
commands: "Fv/Fm" and "Yield" require some time. This time is longer 
with the Panel PC than with GFS-Win. 
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The timing in user-programs is sometimes ambiguous. In general, am-
biguous situations can be avoided by generous timing of the storing inter-
val. In the following the proceeding of the program in ambiguous situations 
is described. 

Fluorescence measurements performed with the command 
"1Yield/y*MP=" take additional time, especially if they include Fo’-
measurements, because the saturating light pulse is given after the gas ex-
change measurements has been taken. Usually the idle time of the next 
measuring interval (Fig. 7, idle time = measuring interval -averaging time), 
which has been set with "Storing Interval =" is used. The maximal time 
required for a Yield measurement in Fo’-mode is 8s. If the idle time of the 
given measuring interval is to short, the measuring interval of the following 
MP is prolonged. As a result, the total Interval set with "Interval =" might 
contain less MPs then intended. If a yield measurement has been started at 
the end of an Interval. The count-down is paused the yield measurement is 
finished before proceeding with the program. 

If averaging of gas exchange data, has not been finished at the end of an 
Interval, the program proceeds without storing the data-set. 

38 



 SOFTWARE DESCRIPTION CHAPTER 3 

39 

Time 
Date 

M.head
calibrate 

Binos 
calibrate 

Data-File
management 

3.8.7 Submenu Option 
Full calibration of the infrared gas analyzer 

needs to be performed with the GFS-Win software, 
but the absolute zero calibration for CO2abs or H2Oabs may be accessed 
here (see chapter 5.2.1). 

With this function, the light source factor and the 
Offset for the Tleaf sensor can be set (see chapter 

5.1.1 and 5.1.2). Other calibrations of the measuring head need to be per-
formed with the external GFS-Win software. 

To set the system time 
 

 

Fig. 13: Dialog for Data file management  

 

Data-File management opens a dialog and key-
pad on the screen (Fig. 13). With the arrow keys a 

file can be selected. The selected file is indicated with small arrows, but 
also its name is shown in the Filename-box. With Rename file or Delete file 
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Prog-File 
management 

Flow Meter 
Offset=0 

Purge time:
60s 

Comment 
 

Report → 
Chart 

Live Data 
→ Chart 

the selected file can be renamed or deleted. Please do not use the symbol + 
within a filename. With all delete all data files are deleted. At the bottom of 
the screen the available disk space is shown. With ESC the data file man-
agement dialog is left. 

Program-File management works analog to the 
Data-File management. 

Purge time is required for the command button 
Auto ZP (see chapter 3.6).  

Comment opens a dialog. Enter maximal 32 
characters and press OK. The comment will be 

stored with the next MP or ZP in the comment column of the report file. 

Flow Meter Offset Recalibrate the flow meter 
offset with this button. Make sure that the flow is 

switched off and also the Impeller is switched off before this button is 
pressed (see chapter 5.3). 

 
Report → Chart clears the chart memory. Af-

terwards the data of the report-file will be read into 
the chart memory and displayed. The button face 
will turn into Live Data→ Chart. If the button is 

now pressed again, live data will be collected in the chart memory and dis-
played in the chart. 
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Components 
Infos 

Errorlist

System
Values 

Chart 
Clear 

Display
 

3.8.8 Submenu Option2 
To display the list of errors (as numbers), which 

might have occurred during operation. A more 
detailed error list, which also indicates the time, when these errors occurred 
can be downloaded using the GFS-Win-software (see chapter 6.3) For in-
terpretation of error number see chapter 6.3. 

Clears the chart memory. The chart will be 
empty after pressing this button. 

Displays the version and serial numbers of 
components within and attached to the control unit. 

To adjust the contrast and brightness of the 
screen. 

Displays values, concerning the function of the 
system. 

Fig. 14: System values  

Under Akku1 and Akku2 are the voltages and current at battery/DC in. 
Underneath is the status of the Battery Control (BÜ). FF means ok, other-
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Touchpanel 
adjustment 

System 
constant 

wise the error number is shown. For the Central Unit (ZE) the status, tem-
perature of electronics (T), voltage (U), the pressure in the CO2 supply 
vessel (Central Unit Ver. 1.04 or higher) and the numeric value for the 
pump regulation (Flow DAC) are given. For the Measuring Head, the 
status, temperature of electronics (T) and voltage (U) are indicated. The 
cycle time indicates the time required for reading and calculating the data. 
TP-X and TP-Y are values of the touch panel adjustment. The lowest line 
indicates the status string. See GFS-3000 manual for interpretation of the 
status string. 

To adjust the coordinates of the touch panel. 

 

 Displays calibration constants and settings (Fig. 
15). 

 

Fig. 15: System constants  

dH2O_Cal, dCO2_Cal, H2O_Quer concern the gas analyzer. The other 
values concern the Measuring Head, here (Fig. 15) the Gas Exchange 
Chamber 3010-GWK1: time lag between sample gas and reference gas, 
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offset and gain of temperature sensors, gain of PAR sensors, 25 and 75% 
value of relative humidity sensor, light source factor (Lights_f), volume of 
the chamber. For adjustment of Tleaf offset (Tleaf_o) and light source fac-
tor (Lights_f), see chapter 5.1.1 and 5.1.2. 
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4 GFS-Win: Installation and File Transfer 

4.1 Installation of the GFS-Win Software 
Updates of the GFS-Win software can be downloaded at: 

www.walz.com. Start the setup-file. The installation will start (see Fig. 
16). Press Next to read the installation information and Next again. 

Fig. 16: Installation of GFS-Win. 

The installation directory needs to be confirmed or changed.  

Fig. 17: Dialog for destination folder. 

Please note that Windows versions higher than Windows XP have spe-
cial restrictions in the subdirectory "Program Files". Operation will be more 
convenient, if GFS-Win is not installed within this subdirectory. 
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The installation type needs to be changed. Chose the lower option, 
GFS-Win (external Computer), and click Next. In the end of the installation 
press Finish. 

Fig. 18: Dialog for installation type. 

After installation, the USB-Port driver needs to be installed, see next 
chapter. 

If the wrong software type has been installed, it may be necessary to 
remove the software. Also old software sometimes need to be removed 
before installation. To remove a GFS-Win version press Start → Control 
Panel →Add or Remove Programs → GFS-Win (Read support info, which 
contains version number) →Remove. In Windows 7, software can be re-
moved with the explorer (Windows-key + e). If the address Computer is 
selected, the command line contains a button for removing programs. The 
external installation provides an uninstall shortcut at Start → Programs 
→GFS 3000 →Uninstall GFS-Win for software removal. 

Before starting GFS-Win, adjust the regional settings of the external PC 
to point for the decimal character and space for the thousand-separator, also 
use a semi colon as list separator. The 24 h time-format should be used 
(Start →Settings →Control Panel →Regional Settings →customize) or 
(Start →Run →"intl.cpl" →customize). 
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4.2 USB-Driver Installation 
4.2.1 Windows 95, 98, ME 

The GFS-3000 can be connected to an external computer using the sup-
plied USB null-modem cable (NMC). When the USB-null modem cable is 
connected to an external computer for the first time, the PC automatically 
recognizes the new hardware and the "New Hardware Wizard" window 
appears. 

Select the option Install from a list or specific location (Advanced). 
Click Next and browse for the location on the provided CD with the appro-
priate USB-Port driver. After clicking Next the Hardware Wizard gives a 
warning. Click on Continue anyway and Finish. If the procedure starts once 
more, please repeat the procedure as described before for the next hardware 
port. 

4.2.2 Windows 2000 
Start the program CDM_Setup.exe from the subdirectory C:\GFS-

WIN\USBPORT. It will take some time until the installation will be con-
firmed. CDM_Setup.exe is also suitable for Windows XP. 

4.2.3 Windows XP and Windows 7 (32 or 64 bit) 
The program CDM(version number).exe needs to be started to install 

the USB-driver. To do this chose Start → Programs →GFS 3000 →Install 
USB-Port. 
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4.3 File Transfer 

Fig. 
19: pull-down list under the menu point On/Off → File transfer 

Connect the PC with the GFS-3000 via the provided USB-cable. Start 
the GFS-Win software on the PC. The measure mode needs to be off or in 
standby mode for file transfer. The GFS-3000 needs to be in the Window 
Settings. During file transfer the baud rate will be 115200 instead of 19200 
for normal operation. In the GFS-Win software press Menu point On/Off → 
File transfer and chose between several transfer options. 

Data files will be downloaded from the GFS-3000 and translated into 
.csv-files. Downloaded files will be stored in the actual subdirectory for 
data. It is possible to change this subdirectory by opening an existing or 
new report file in GFS-Win with Settings-> Filename in the subdirectory 
intended for data storage. 

User-program files (.prg) can be transferred to the GFS-3000 or 
downloaded from it. The actual subdirectory for the user program files 
during file transfer is the same subdirectory as used during GFS-Win opera-
tion. It can be changed by opening a new or existing user-program in an-
other subdirectory within the program window of the GFS-Win software. 

Also the ini-file and error list, GFS3000.ini and GFS3000.err, can be 
downloaded. These files will be stored in the subdirectory of the GFS-Win 
software or in the subdirectory My Documents\ GFS3000\ini depending on 
how the GFS-Win software is setup. 
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5 Calibration and Adjustments 
Withthe Panel-PC only the most important calibrations can be carried 

out. For more calibration options read the manual for the GFS-3000 and 
use the external software GFS-Win. 

5.1 Measuring Had 
5.1.1 Offset of Thermocouple for leaf temperature (Tleaf_o) 

The thermocouple measures the temperature difference between Tcuv 
and its tip touching the leaf. During the offset adjustment, this difference 
will be set to zero. It is important, that the temperature control is off and 
has not been used for a while before this function is used. Insert a piece of 
paper, close the cuvette. The impeller speed will be set to 5 after choosing 
the menu point Tleaf-Offset. Now wait 5 min and watch the values in the 
quick-view column until the temperature of Tcuv and Tleaf have stabilized. 
Press Option → Measuring Head Cal. → Tleaf-Offset. The Offset will be 
set to a new value and stored in the Measuring Head. 

5.1.2 Adjustment of Light Source Factor 
The intensity of the light source is 

measured with the PARtop or PARbot sensor 
inside the cuvette in dependence of the side of 
attachment. These light sensors are located at the 
rim of the cuvette frame, respectively. In contrast 
to sunlight, which is uniform over large areas, the 

light coming from an artificial light source may decrease towards the rim, 
where the light sensor is located. Whenever one of the light sources (LED 
Light Source 3040-L, LED-Array/PAM-Fluorometer 3055-FL, or the Im-
aging-PAM) are switched on, the measured intensity of PARtop or PARbot, 
depending on the chosen light mode, is multiplied with the light-source 
factor stored in the measuring head. The light-source factor is specific for 
every light source. If the light source is changed, a new adjustment is re-
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quired. Once the light-source factor is determined for a given light source, 
the known value can be entered without a new determination. 

For carrying out the 
determination of the light-
source factor the external 
Miniature Quantum Sensor 
MQS-B/GFS and the provided 
adapter plate (see picture) will 
be necessary. If a fluorometer 
is used, it must be enabled. 

Open the cuvette and 
hold the external light sensor mounted in the adapter plate at leaf-level in 
the center of the cuvette. Set the light to mode PARamb and enter the set 
value 1000 µmol m-2 s-1 . Read the value indicated for PARtop (or if the 
light source is at the lower side fro PARbot). Calculate the light source 
factor, which is the indicated value for PARamb (1000 µmol m-2 s-1) di-
vided by the indicated value for PARtop (or PARbot respectively). The 
result is the light source factor - usually a number between 1.2 and 1.5. It 
needs to be entered into the measuring head with Option → Measuring 
Head Cal. → Light source factor. Adjust the light mode back to PARtop or 
another intended mode before starting measurements. 

5.2 Gas Analyzer 
5.2.1 Calibration of Gas Analyzer 

The calibration procedure has been improved since GFS-Win version 
3.31. We recommend doing the calibration with the set-up described here 
(e.g. air-cycling) and with the latest version of GFS-Win for both types of 
instruments, having Control Unit Model 3000C or 3100C. With the Panel-
PC software the absolute zero-point calibrations is possible. For a full cali-
bration, the external GFS-Win software needs to be used. Also with the 
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Panel-PC software the set-up with air-cycling as described here may be 
used. 

The full calibration includes the zero point and span calibration of the 
absolute signals. In order to carry out a zero-calibration, the analyzer 
should be purged with zero gas until the measured values no longer display 
a drift. There are two causes for drift, the warm-up drift and the purge-drift. 
The warm-up drift is a consistent drift after the gas analyzers have been 
switched on. Take your time for calibrations. 

The warm-up drift is typically 15 min for CO2 and 30 min for H2O, 
but may take up to 1 h for CO2 and up to 2 h for H2O. The calibration is 
best performed after this warm-up period. For calibration purposes, we 
recommend a longer waiting time than for measurements. If the gas ana-
lyzer can be kept on overnight the warm-up drift would be avoided. It may 
be advisable to calibrate the analyzer in the evening after measurements for 
the next day (or week) rather than in a hurry in the morning. The gas ana-
lyzer is switched on, when the measure mode is switched on. It is only 
switched off, if the measure mode or Power is switched off, but not, if the 
GFS-3000 is switched into standby mode. It is possible to feel by hand 
whether the analyzer is/was on, because the instrument would have become 
warm. The purge-drift is short for CO2 less than 5 min, but very long for 
H2O 1-2 hours. 
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5.2.2 CO2 Zero using CO2 Absorber 
• The CO2 zero calibration requires fresh soda lime (CO2 absorber) 

connected. Note that the indicator of the soda lime only indicates 
violet directly after usage. The next day the violet color may have 
disappeared. Nevertheless the soda lime is used. With very dry gas, 
the indicator may not work. 

• The Drier tube must be replaced by the Mixing Volume 3000-
C/MV.  

• The humidifier may be replaced by a tube. 

• Connect the Measuring Head and close it. Alternatively the gas 
connections for the measuring head can be replaced with a short 
tube. 

Fig. 20: Set-up of the system for CO2 absolute zero calibration with air-
cycling. 

• Although it is possible to calibrate the CO2 zero with an open flow, 
air-cycling will save CO2 absorber material In order to establish 
air-cycling, connect all outlets with AIR IN via tubes as shown in 
the picture. The air-cycling tube may be any clean tube made from 
any material since it is located before the CO2 absorber. Only(!) 
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during zero calibrations the air may be cycled. Please, do not forget 
to take the air-cycling tube off directly after zero-calibration. 

• Chose Option→ Cal. Gas Analyzer→ CO2 zero.  

• The settings for Flow, CO2 control and H2O control will be ad-
justed automatically. In order to speed up the purging process, 
valve 5 may be opened for a short period of time. Also the Measure 
Mode is automatically switched between MP and ZP to flush all 
gas ways with calibration gas.  

• In mode ZP the flow through the analyzers may be increased by 
opening valve 1. It can be opened while watching the increase of 
flow in the flow indicators. If valve 1 is not changed, reaching zero 
will take longer, but its readjustment can be avoided. 

• Click OK to go to the next step.  

• The two upper fields in the Quick-View Column of the GFS-Win 
main window and the Chart show the CO2 absolute value of the 
reference cell (CO2abs) and the CO2 absolute value of the sample 
cell (CO2sam). If both values have stabilized without drift OK may 
be clicked. The Info line will display a count-down while perform-
ing the calibration, please wait. If the calibration shall be cancelled, 
press Stop. 

• Check the calibration: Is CO2abs  and CO2sam (or dCO2ZP) close 
to 0? 

• Either set-up the system for the next calibration (CO2 span or H2O 
zero) or for measurements: 

Disconnect air-cycling tube. 

If valve 1 has been opened, it should be readjusted. To do this, the 
system needs to be in mode MP, the measuring head needs to be 
connected and closed. Switch the flow on. Adjust valve 1 until both 
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flow indicators show equal height (see chapter 5.4 and manual for 
GFS-3000).  

If valve 5 has been changed, chose Option2 → System Values. In 
mode MP adjust valve 5 until the value for Flow DAC shows 1500 
± 100, or close valve 5 for high flow rates. 

If necessary, enable the measuring head with On/Off →Enable 
Components. 

5.2.3 H2O Zero using the H2O Absorber  
H2O is a small molecule, which is well absorbed by surfaces. Hence it 

takes a while until the system is completely dried for the H2O zero calibra-
tion. We therefore recommend regular checking of the H2O zero value, but 
only a complete calibration, if there is enough time for good drying. In 
order to be able to dry as long as desired even in wet climates, without 
flushing too long, so that the silica gel would become wet during the drying 
procedure, we recommend air-cycling (see Fig. 21). Please, do not forget to 
take the air-cycling tube off directly after zero-calibration. 

• Use freshly dried Silica Gel in the DRIER tube. Note, if silica gel is 
burnt, it may stay orange-black although being wet. 

• Remove the tube CO2 absorber and replace it by the Mixing Vol-
ume 3000-C/MV. 

• The humidifier may be removed and replaced with a tube. 

• Use an air-cycling tube to connect all outlets with the filter at AIR 
IN. The air-cycling tube may be any clean tube made from any ma-
terial since it is located before the drier. Please, do not forget to 
take the air-cycling tube off directly after zero-calibration. 
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Fig. 21: Set-up for H2O zero calibration with air-cycling . 

• The Measuring Head must be connected and the cuvette closed. Al-
ternatively, the gas connections for the Measuring Head can be 
shortened with a tube. 

• Chose Option→ Cal. Gas Analyzers→ H2O zero. 

• The parameters for Flow, CO2 control and H2O control will be ad-
justed automatically. In order to speed up the purging process, 
valve 5 may be opened for a short period of time. Also the Measure 
Mode is automatically switched between MP and ZP to flush all 
gas ways with calibration gas. 

• Click OK to go to the next step. 

• In ZP mode, opening valve 1 will increase the air flow through the 
analyzer and therefore speed-up the drying procedure. Watch the 
mechanical flow indicators rise as the flow through the analyzers 
increases while opening valve 1. 
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• The two upper fields in the Quick-View Column show the H2O ab-
solute value of the reference cell (H2Oabs) and the H2O absolute 
value of the sample cell (H2Osam). If both values have stabilized 
(after 10 to 30 min), a H2O zero point calibration can be carried out 
via OK. Both H2O absolute values will be set to 0. The calibration 
can be cancelled by pressing Stop. 

• Check the calibration: Is H2Oabs and H2Osam (or dH2OZP) close 
to 0? 

• Either set-up the system for the next calibration or for measure-
ments: 

Disconnect air-cycling tube. 

If valve 1 has been opened, it should be readjusted for measure-
ments, to do this, the system needs to be in MP mode, measuring 
head needs to be connected and closed. Switch flow on. Adjust 
valve 1 until both flow indicators show equal flow through both 
sides of the gas analyzer. 

If valve 5 has been changed, chose Option2 → System Values. In 
mode MP adjust valve 5 until the value for Flow DAC shows 1500 
± 100, or close valve 5 for high flow rates, where DAC values that 
low can not be reached. 

If necessary, enable measuring head with On/Off →Enable Com-
ponents. 

 

5.3 Offet of Flow meter 
With flow meter and impeller set to zero, press Options→ Flow Meter 

Offset. The momentary Offset and actual flow will be indicated. After 
pressing OK the Offset will directly be changed in the Flow Meter, so that 
the indicated flow becomes zero. 
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5.4 Valve adjustment 
A short description is given on how the valves shall be adjusted with 

the software of the Panel-PC. For more detailed information on the valve 
adjustment and function see manual for the GFS-3000. 

Table 2: Valve adjustment, valves are listed in the order of adjustment. It 
may be necessary to roughly adjust valve 3 and 5 before starting. 

Valve Mode Adjustment 

4 ZP Equal flow at flow indicators ANALYZER REF and 
SAMPLE. 

3 MP Flow through Analyzer 800 ml/min at flow indicator 
ANALYZER SAMPLE or until closed (with low 
flow rate). 
It might be necessary to close valve 5 first. 

1 MP Equal flow at ANALYZER REF and SAMPLE. 

5 MP Adjust so that DAC Flow is 1500 +- 200 (voltage for 
pump) or until closed (with high flow). 
DAC-Flow can be found with  
Option2 →System Values 

2 MP ↔ ZP Total flow in ZP Mode: 
Watch the DAC-Flow value (Option2 →System Val-
ues) while switching between ZP and MP. Adjust 
valve 2 in ZP-Mode, so that the DAC-Flow value is 
the same in MP- and ZP-Mode.  
A user-program may be used during adjustment: 

Mode MP 
Interval = 20 
Mode ZP 
Interval = 40 
Repeat Run 

Flow indicators will be lower in ZP- than in MP-
Mode.  
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6 Appendix 

6.1 Technical data of Control Unit 3000-C 
Design: Aluminum housing featuring integrated PC module, large graphi-

cal LC-display with touch screen, 4-channel CO2/H2O gas analyzer, 
flow control, CO2 control (supplied via small cartridges or cylinders) 
and H2O control (for drying and humidifying). Pneumatic connectors 
for air inlet, measuring head and four vents. Sockets for cable con-
nections with Measuring Head 3010-S (or other measuring heads 
supplied by us), PC (USB interface), two Auxiliaries, two Li-ion 
Batteries 3025-A (or AC Power Supply 3020-N or external DC) and 
one additional component 

CO2/H2O gas analyzer, Mass flow measurement, CO2 control, H2O 
control, Auxiliaries: 
• same as Control Unit 3100-C 

Integrated user interface: Panel PC 486 SX/33 MHz with transflective 
graphical LC-display 320 x 240 dots (effective display area 11.5 cm 
x 8.6 cm) with backlight and touch screen 

Data storage capacity: 64 MB flash card 

Measured and calculated parameters: CO2 absolute, CO2 difference, 
H2O absolute, H2O difference, flow, ambient pressure, 2x auxiliaries, 
cuvette temperature (upper and lower half), leaf temperature, ambi-
ent temperature, PAR in upper part of the cuvette, PAR in lower part 
of the cuvette, external PAR, impeller frequency, evaporation, VPD, 
H2O conductance, net photosynthesis, internal CO2 concentration. 
Recalculation of stored data is possible, 

 In combination with LED-Array/PAM Fluorometer 3055-FL (GFS-
3000FL): Fo, Fm, Fm', F, Fo', Fv/Fm (max. PS II quantum yield), 
ΔF/Fm' = Y(II) (effective PS II quantum yield), qP, qN, NPQ, ETR 
(i.e. PAR x ΔF/Fm') 
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PC interface: USB 2.0 

Input Voltage: 14-16 V 

Power Supply: Field replaceable rechargeable Li-ion Battery 
14.4 V/15 Ah 3025-A (two batteries supplied), external 16 V DC, 
AC Power Supply 3020-N for laboratory operation 

Operating time: 2 to 4 hours typ. with one Li-ion battery, 4 to 8 hours typ. 
with two Li-ion batteries 

Operating temperature, Dimension, Weight: same as Control Unit 
3100-C 
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6.2  Symptoms and Solutions 
Table 3: Symptoms and Solutions 

Panel PC  
The screen of the Panel PC is 
black 

Occurs, when it is hot. Try to cool the 
screen. Adjustment of the contrast can be 
done by pressing this field  at the 
lower right-hand corner of the screen. 
Generally, the screen contrast and bright-
ness can be adjusted under Op-
tion2→Display. Also the contrast can be 
set to its default setting during the start-up 
of the system by pressing the letter "W" of 
the Walz-logo, which can not be seen, if 
the screen is black, but the location can be 
guessed. 
 Battery Charger 

Battery Charger shows "LiIon 
error" 

Battery charger is not switched on or bat-
tery has been discharged to low, discon-
nect and reconnect battery (see manual for 
GFS-3000 chapter on batteries for more 
details). 
Model LC-02: Note that, if the charger is 
not switched on, the display of the charger 
is powered by the connected battery and 
the battery will discharge. 

6.3 Error Messages 
Table 4: Errors notified by Panel PC. 
Error Code Explanation 
0001 Memory error 
0002-0005, 0007, 0008 Com-port initialization error 
0006, 0009-0016 Communication error (Panel PC to external com-

puter): Check cables, try again 
0020-0051 File error, read or write errors to memory card. If 

no strange letters and not more than 8 letters have 
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been used in filenames, call Walz 
0300-0315 Initialization error, Measuring Head (Memory 

error, Run-time error, Initialization failure, Volt-
age error or Communication errors) 

1001 Memory error, Battery Control 
1002-1005, 1007, 1008 Com-port initialization error, Battery Control 
1006, 1009-1015 Communication error, Battery Control 
11xx see manual of the GFS-3000 
2001 Memory Error, Central Unit 
2002-2005, 2007, 2008 Com-port, initialization error, Central Unit 
2006, 2009-2015 Communication error, Central Unit 
21xx see manual of the GFS-3000 
3001 Memory error, Measuring Head 
3002-3005, 3007, 3008 Com-port initialization error, Measuring Head 
3006, 3009-3015 Communication error, Measuring Head 
31xx see manual of the GFS-3000 
4001 Memory error, Fluorescence Module 
4002-4005, 4007, 4008 Com-port initialization error, Fluorescence Mod-

ule 
4006, 4009-4015 Communication error, Fluorescence Module 

6.4 LED-Code 
Table 5: Power LED of Central Unit 3000-C" 

LED Meaning 
off Power is off, 
green blinking Power is on, operation ok 
green permanently Program crash or hardware error. 

Switch power off and back on 
red permanently Program crash or hardware error. 

Switch power off and back on 
red/green blinking Supplied voltage to low. 
red blinking Error detected by Software, read error code 
orange blinking Error detected by Software, read error code 
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